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Introduction

The MAGIX® Music Editor is an independent sub-pro-
gram for audio processing or own recordings.
All audio formats are displayed as waveforms in the
project window and can be processed there in a variety of
ways.
In the case of AVI videos, the video sound track is ex-
tracted and processed as a waveform.

Quickstart
Record
For your own recordings you should have an audio source
attached to the soundcard input, e.g. a record player or
microphone.
Then click the Record button in the transport control to
open the record parameter dialogue.
Activate the Monitor button! This function allows you to
listen to the recording material before recording, or lis-
ten while recording.
The LED peak metre shows what is received by the
soundcard input. If the level is too high, the LED peak
metre indicates a ‘Clip’ display (top LED). You definitely
need to reduce the volume.
Actual recording starts only when you click the Record
button in the record dialogue. Start!
You are recording. The MAGIX® Music Editor shows this
in the record window with a counter (recording time dis-
play).
If you click the Stop button, the MAGIX® Music Editor
stops the recording and shows a dialogue, where you can
then choose to keep or discard the recording.
If you click the Delete button, the program returns to the
record window. You can then repeat the recording or stop
altogether.
If you press the OK button, the MAGIX® Music Editor
will show a waveform of the recorded material in a project
window. You can save it as an audio file or continue
processing.

Audio processing
The MAGIX® Music Editor allows you to cut, process and
refine your recording and any other audio material.
Audio material is presented in waveform in a project win-
dow. The various zoom and editing functions allow you
to move between different views.

Record

Record parameter
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For all processing: the area to be processed must first be
marked on the waveform with the mouse.
The Effects menu allows you to filter unwanted noise
disturbance or replace unwanted passages with silence.
You can also apply ‘real’ sound effects, like reverb or echo.
The audio material is best saved as a so-called HD-Wave
project on the hard disk. The files get the suffix ‘HDP’ .
Most audio programs can read and process HDP projects
directly.

Terminology and Editing Concepts
The following lists some specific terms that where de-
fined to describe components of MAGIX® Music Editor
that are mentioned frequently throughout the documen-
tation. Even if you were somewhat familiar with some of
the particulars, we would like to encourage you to read
the definitions for the individual terms. The terms are
specific context related and are not further covered in the
rest of the documentation.

Section
MAGIX® Music Editor can display any project window in
up to three sections. This enables you to show the com-
plete sample in one section while displaying smaller sec-
tions in one or two other sections. Each section can be
accessed and edited in separately.

Active Section when using Zoom Levels: If Zoom
commands are used on one of the display sections, such
as the buttons on the Positionbar, it is important to des-
ignate the section that is to be zoomed. Click on the left
or right scrollbar of a section to activate it.

Range
A range can be selected with the mouse. Ranges can be
played back with the Spacebar. It is defined by the begin-
ning and end (horizontal) and by the upper and lower
limits (vertical).
The range is utilized to earmark sections, which will be
used to manipulate the material in the range (Cut, Insert,
Normalize, Fade-In, Fade-Out, Move, Effects, Delete, etc.).
The second function is the definition of loops, which are
repeated during playback.
The third task of the range is the configuration of section
edges in which graphical data is displayed. Especially the
upper and lower edges may be analyzed during editing,
which is not the case with some of the function groups!
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Every project can have an unlimited number of ranges
defined. Up to 10 ranges can be accessed directly through
the function keys.

Selecting a Range: To select a range, move the mouse
pointer to a section in the window display and click the
left mouse button. While holding the button clicked, drag
a range by moving the mouse to the right. The range is
indicated by the vertical rectangle displayed in the win-
dow.
Next, release the mouse button. MAGIX® Music Editor
displays the horizontal range values right underneath the
title bar of the project window.

De-Selecting a Range: If you want to select a different
range or want to deactivate the current range selection,
click the mouse button once into the project window. The
previous range disappears and the window can be used
to select a new range.

Changing a Range: If you want to change an already
selected range outline (beginning, end, upper, and lower
border), simply click the left mouse button into the range
and while holding the button, move the mouse in the
direction you want to extend or shorten the range. As soon
as the mouse pointer crosses over the current range bor-
der, the program picks up the border and snaps it to the
mouse pointer. You now can move the range border to
the new point and release the mouse button.

Moving a Range Horizontally: Hold the Ctrl or Shift
key while clicking inside a range. Next, hold the left
mouse button clicked and move the range to the new
position. Release the mouse button to place the range at
the new location.

Saving Ranges and Special Range Commands: Ranges
and markers can be saved with the help of menu func-
tions or keyboard shortcuts.
MAGIX® Music Editor can store an unlimited number of
ranges and markers. These and other special functions
to define, change, and use ranges can be found in the
menu Ranges.

Moving of Ranges in Small Increments (Keyboard

Shortcuts): By holding the Shift key and using the cur-
sor keys, ranges can be moved in small increments. An
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overview of all keyboard shortcuts can be found in the
Shortcuts section.

Changing Range Ends in Increments Using the

Mouse: This is most often needed when searching for
optimized loop borders in Wave projects. The sections
can be split with a keyboard shortcut (Shortcut: ‘b’) or with
Range->Split Range. All range borders are displayed with
a high-resolution zoom level.
Using Shift + b returns the display to a single section.

Clip
The Clip is a storage place for samples from Wave projects,
which are copied from a Wave project window and can
be inserted in the same Wave project or a different one.
In addition, the content of the Clip can also be mixed with
that of another Wave project window. The Clip always
takes on the attributes of the originating project (Bit Rate,
Sample Rate, Mono, Stereo Mode). The Clip is repre-
sented on the screen with a window that contains the word
‘Clip’ in its title bar. Otherwise, the Clip is like any other
project that can be played back, edited and saved with a
different name.

Marker
Markers are used to store specific time locations. They
are indicated on the upper edge of the sample display by
small triangles and show any assigned name or number.
These markers can be moved with the left mouse button.
Any project can have an unlimited number of markers.
Up to 10 of these markers can be accessed through the
number keys. A marker that has been assigned to one of
the number keys carries the name ‘1’ through ‘10’. The
menu option Range>Store Marker>Other can be used to
store markers with specific names. These names are dis-
played next to the marker in the project window.
If you click the right mouse button in the area where the
markers are displayed, a context sensitive pop-up menu
is displayed, which contains additional commands to
manipulate markers.
To select a range between two markers, click on the trian-
gle of the first marker to activate it, followed by holding
the Shift key and clicking on the second marker.
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Play Cursor
The Play Cursor or the Position Line is the vertical mov-
ing line during playback and shows the current playback
position.
The start position of the Play Cursor (playback start) is
set by clicking the left mouse button into the project win-
dow. This deselects any previous range.

Wave Projects
A Wave project contains audio data. Access to the Wave
project is obtained by selecting the corresponding Wave
project window. The title bar of the window displays the
name of the Wave project, the bit resolution, the length
of the sample, and the resulting storage requirement. To
activate the window, simply click into the project window.
MAGIX® Music Editor can work with an unlimited
number of Wave project window displayed on the screen.
Working in a Wave project window works much the same
as with conventional sample editing programs and you
may already be used to those conventions.
To perform destructive editing, it is necessary to select a
range with the left mouse button.
Clicking the right mouse button opens a context sensi-
tive pop-up menu. The menu displays the most impor-
tant functions for working with destructive processing.

Mono Wave Project: Contains mono audio data.

Stereo Wave Project: Stereo audio with a standard two-
channel graphical display (combined display of both
stereo channels). Contains stereo audio data. The sample
values for the right and left channels are contained in
the same file in successive order.
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Open Project
WAV (*.wav): WAV Files (Standard Audio Format).

HD project (*.hdp): This is the data format for MAGIX®

Music Editor files.
When opening a WAV file, MAGIX® Music Editor auto-
matically creates an associated HD Wave project. The HD
Wave project file contains additional information about
the audio file, such as marker positions. Once the WAV
file has been opened once in MAGIX® Music Editor, it
can be loaded as a HDP from that point on.
Please note that direct editing of WAV files from a CD-
ROM is not possible. Please use Import Sample instead.

Keys: w for WAV files
Shift + L for HDP files

Toolbar:

Load CD Track(s)...
This function allows you to import audio data from most
CD ROM drives and CD-Writers in the digital domain,
without any loss in quality. Please contact our technical
support for the latest list of supported drives.
The HD Wave projects are recorded as WAV files and can
therefore be edited with other audio editing programs
without having to convert them first.
To do this, please follow these steps:
1. Open the drive list dialog and select your desired CD-

ROM drive, if you have more than 1 drive
2. Click the ‘Track List’ Button
3. In the CD track list dialog select one or more tracks in

the list box
4. Click on ‘Copy Selected Track(s)..’
5. Select a filename for the new WAV file or HD Wave

project and click O.K.
6. Now the audio data is copied from the CD-ROM to

your hard disk as a new WAV file.

Features of the Drive List Dialog:
Track List (Copy, Play)...: This button opens the track
list dialog for selecting several audio tracks of your CD.
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Configuration: This button opens the drive configura-
tion dialog, where you can select special copy modes and
SCSI IDs.

Reset: Restores the standard drive settings.

Add Drive: Creates a new drive entry in the list for edit-
ing the configuration data.

Delete: Deletes the selected drive entry from the drive
list.

Save Setup: Saves the drive list and all configuration data
in a *.cfg file.

Load Setup: Loads the drive list and all configuration data
from a *.cfg file.

Features of the Track List Dialog:
Copy selected Track(s): This button starts the audio data
copy process, all selected tracks from the list are copied
into one WAV file.

Play: Starts audio playback of the first selected track in
the list.

Stop: Stops audio playback.

Pause: Stops audio playback for later resuming.

Resume: Resumes playback if previously paused.

Select all tracks: Selects all tracks of the CD for copy-
ing the complete volume. You can select multiple tracks
with Ctrl + mouse click or with Shift/ Alt + Cursor keys!

Deselect tracks: Closes the drive door of the CD ROM
drive.

Features of the CD ROM Drive Configuration Dia-
log:
Drive Name: Lets you edit the name of the drive in the
list. This is useful if you create more than one entry ac-
cessing the same physical drive.

Host Adapter Number: Lets you specify the number of
your SCSI adapter – normally 0.
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SCSI-ID: Lets you set the ID of your CD ROM drive. Be
sure to set the correct ID, there is no error checking!
SCSI-LUN: Select the SCSI LUN parameter, normally 0.

Alias: Lets you select a manufacturers type of your CD
ROM drive.

Copy Mode Normal: Copies the audio data without any
software correction.

Copy Mode Sector Synchronization: Copies the au-
dio data using a software correction algorithm. This is
useful, because some CD ROM drives cannot seek exactly
to the same position between two read accesses but
MAGIX® Music Editor can correct these differences us-
ing this algorithm.

Copy Mode Burst: Optimizes the speed of the copy proc-
ess, no software correction is done.

Sectors per Read: Defines the number of audio sectors
per read cycle, the higher the number the faster the copy
process will be. Not all SCSI adapters support more than
27 sectors!

Sync Sectors: Defines the number of audio sectors used
for the Sector Synchronization. A higher number results
in a better synchronization but also in a slower copy proc-
ess.

Save Project
The current project is saved with the name displayed in
the project window. If you previously have not specified
a name for your project, MAGIX® Music Editor will ask
you to do so.

Toolbar:

Keys: s

Save Project as...
You can define the path and name of the new project you
want to save your work under. HD Wave projects are re-
named on the hard disk. MAGIX® Music Editor will not
generate a copy of it for reasons of conserving space on
your hard drive.
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Keys: SHIFT + s

Save in Format
With this function, you have the possibility to convert
projects between the different MAGIX® Music Editor
Wave project formats. An option is the conversion to and
from stereo Wave projects to mono Wave projects.

Rename Project...
The ‘Rename Project’ command will let you rename a
project file rather than save it to a different file. For RAM
Wave projects, only the internal names are changed (with-
out being saved). But all corresponding files are renamed
immediately in the case of HD Wave projects.
RAM Wave projects need to be saved after renaming the
project.

Delete Wave project...
HD Wave projects are deleted from the hard disk. Use
this command with caution, as all corresponding files are
lost.
(If you wanted to delete a HD Wave project (HDP) from a
file manager such as Windows Explorer, it would also be
necessary to delete the graphic files related to the project
files.)

Import Sample...
MAGIX® Music Editor gives you the option of importing
Wave, AIFFor Sample Dump files into a MAGIX® Music
Editor project. You will need to specify which type the
project is going to be, a RAM Wave Project, or a HD Wave
project.

Difference between Open->WAV and Import
Sample->WAV:
The command Open->WAV opens an already existing
WAV file and edits the file as a HD Wave project.
MAGIX® Music Editor automatically creates a HDP file
and the corresponding graphic file in the source folder.
When importing a WAV file, the complete file is copied.
Additional hard disk space is needed and the process takes
much more time, since the audio file has to be copied
with Open Project->WAV. Import Sample->WAV has to
be used when intending to use the WAV file as a RAM
Wave project.
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Export Sample...
The command ‘Export Sample’ will let you export HD
Wave project or RAM Wave project files into
Wave-/ MPEG (1:10), or – with an external encoder – as
MP3 files and Dump files. Keep in mind, that your project
file needs to be either in the 8- or 16-bit mode. You can
save it both in Mono or Stereo format.

A Note about Export Sample:
The audio data files for HD Wave projects can be directly
loaded or imported as WAV files by other audio applica-
tions. The command Export Sample is only necessary if
you want to copy the audio file. Keep in mind that the
hard disk requirement increases and that the copy proc-
ess takes additional time.
This command has to be use to convert RAM Wave
projects into WAV files.
Please note that direct editing of WAV files from CD-
ROMs is not possible. Please use Import Sample instead.

Record...
This menu option opens the Record window. All neces-
sary settings for the recording can be performed here.

Record mode: Select between Stereo and Mono.

Sample Rate: Select the sample rate of the audio file.
Make sure that your sound card supports the chosen sam-
ple rate.

Device: This selects the desired device driver you want to
use for the recording. If you have more than one sound
card installed in your system, this window will let you
specify which card to use. Make sure the sound card is
properly installed in Windows and is operational. If you
do not see an entry in this window, check whether a de-
vice driver has been installed for your sound card. This
usually is done during the software installation for your
sound card.

? (Device): By clicking on the '?' button you can check
on the record capabilities of the selected sound card. It
shows you information on the sound card driver and it's
capabilities.
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Monitor: This checkbox activates the VU meters. Most
sound cards also allow you to preview the audio signal
you are about to record and depending on the features of
the sound card, you will be able to monitor the recorded
signal during the recording.
To keep the system requirements down, you may wish to
disable the monitor function if it is not crucial to the re-
cording you are doing. This will lower demand on the
computer system, which may be required if you are work-
ing on a slower system.
During the recording, the meters will react more slowly
due to the priority level change. The most important task
is to keep the recording error free. For this reason,
MAGIX® Music Editor will switch the updating of the VU
meters to a lower priority to not overload the computer
system. This results in a slower reaction time of the me-
ters. The levels are still shown with the correct values.
Also, if you use lower buffer settings, the meters are up-
dated in faster intervals.

Corel/Osci: A oscilloscope view can be opened to dis-
play the wave form in a scaleable window. When activat-
ing the Phase check the phase correlation of a stereo sig-
nal can be displayed.
A vertical line represents a mono signal, a horizontal line
represents a signal with a phase inversion, which is not
wanted in most cases.

Record Time: This counter indicates the length of the
actual recording in minutes, seconds, and milliseconds.

Disk Space: This counter shows you the available disk
space in total track minutes for the selected sample rate
and record mode. This counter does not decrease during
the recording. It is updated after the recording takes place.

Help: This brings up the context sensitive help system
with information on the features in the Record Param-
eter dialog.

New (Button 1): The path to the left of the button indi-
cates the location of the audio file that is to be recorded.
If you click on the New button you may enter a new name
for the audio file or a new location. This is an easy way to
target specify directories or hard disks as destinations for
the new audio files. If you select a new name, the Wave
project is renamed as well.



18

Menu File

Set Marker 1: You can drop markers into the project. The
current position of the play cursor is used to drop a marker
at positions you want to select for later clean-up or simi-
lar tasks.

Record: Starts recording by activating this button.

Stop: Stops the recording process. MAGIX® Music Edi-
tor will ask you whether you wish to keep the recording
or delete it.
Should the computer become overloaded due to swap-
ping data or hard disk access for example, simply inter-
rupt the recording with a click of the right mouse button
or the space key.

OK: Closes the Record Parameter dialog.

Key: r (second r starts recording)

Properties > Project Information
This will show you information on the current project.
This includes creation date, memory size, path and file
names.

Key: i

Properties > Text Comments
You can enter text comments to the current project via a
simple text editor. This text can be displayed at each new
opening of the project. This will preserve important in-
formation about the project together with the audio ma-
terial.

Preferences > System
In the ‘System’ menu, you have options to fine-tune
MAGIX® Music Editor. You can specify parameters such
as paths and play and recording buffers.

Im/Export: To enter the default path for wave import and
export. Click on the ‘?’ button to bring up another win-
dow to look for a specific directory in case you do not
know the full path.

HD Wave Projects: To adjust the default path for HD
Wave projects.
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Play/Record Buffer: This setting determines the buffer
size for the playback and recording of audio files. Larger
buffer settings may lead to a more stable playback on
slower systems or at full CPU load. The number of si-
multaneous playback tracks increases. However, the re-
sponse of the computer slows down, which may have an
adverse effect on real-time effect editing. We therefore
suggest finding an optimal compromise for your indi-
vidual system.
For simultaneous playback and record (Record while Play)
the buffer settings for the HD Record and HD Buffer
needs to be the same.

HD Wave Buffer: The default setting is 8000 Samples.
This buffer is used for the playback of HD Wave projects.
To gain faster response times, try smaller settings.

Real Time Buffer: The default setting is 8000 Samples.
This buffer is only used for the real-time preview in the
Effect menu dialogs.

Buffer Number: This setting determines how many of
the above buffers are to be utilized (values between 2 and
9). A higher setting for Buffer Number secures a more
stable operation. However, the memory requirement in-
creases and the response time decreases. The actual buffer
utilization can be monitored with the status bar in the
lower right-hand of the MAGIX® Music Editor screen.

HD Record Buffer: The default setting is 8000 Sam-
ples. This buffer is used during the recording of audio
material and determines the length of the data block that
is written to the hard disk.

Disable menus and buttons if function is not avail-

able: When checking this option, only those menu op-
tions appear in the menu selection, which are actually
available with the type of project window.

Check the Spacebar for Playback Stop in the Back-

ground: The spacebar is used for playback start and stop.
If MAGIX® Music Editor is playing in the background,
(another Windows application takes the focus), this op-
tion determines whether the spacebar is monitored to stop
playback in MAGIX® Music Editor.
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Preview Time: This determines the length of preview for
the non real-time preview in the Effects menu dialogs.
The non real-time preview is used for very processing
intensive effects in the destructive Wave editing portion
of MAGIX® Music Editor (Menu ‘Effects’).

Keys: y

Preferences>Undo Definitions
The depth of undo can be specified. A value of '20' means
that the last 20 changes can be undone.

Preferences>Colors
MAGIX® Music Editor lets you specify the color for vari-
ous areas of the screen. Use this menu option if you want
to change the default color to another one.

Exit
This command will exit MAGIX® Music Editor. Please
note that all changes made to any project not saved prior
to exiting will be lost.

Keys: Alt + F4
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Undo
MAGIX® Music Editor offers you a comfortable way of
tracking your changes. Up to 100 changes can be kept in
memory and traced backwards
Range and marker manipulations can also be undone
using the ‘Undo’ feature.
Thanks to this extremely efficient feature, critical opera-
tions can simply be tried and then reversed to return to
the original status if the results are not satisfactory.

Keys: CTRL+z

Redo
Redo revokes the latest undo command.

Keys: CTRL+a

Cut
The audio data in the selected range are copied from the
current Wave project into the Clip. The material behind
the removed range is merged with the material in front
of the removed range to close the gap. The complete Wave
project becomes shorter.
Please keep in mind that the Clip always contains the same
attributes as the Wave project the material was copied or
removed from.
If you cut material from a mono Wave project, the Clip
becomes a mono Wave project. If material from a stereo
Wave project is cut or copied to the Clip, the Clip becomes
a stereo Wave project. Another attribute adopted is the
bit resolution and the sample rate of the originating Wave
project. The previous contents of the Clip are deleted.
After a successful removal of the selected material,
MAGIX® Music Editor drops a marker at the position the
removed range previously started. This allows you to in-
sert the contents of the Clip into the Wave project at the
exact same spot if you accidentally removed the material.
Use the function Edit->Paste/Insert Clip to insert the Clip
contents.

Toolbar:

Keys: CTRL + x or x
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Delete
The data of the current range is deleted. The sample data
after the deleted range is added at the position the de-
leted range started. The sample length becomes shorter.
Please note that this command will not save the deleted
data to the Clip. If you want to preserve the deleted sam-
ple data, use the ‘Cut’ command. Using this the ‘Delete’
command will delete the data from the current sample
and preserve the contents of the Clip.

Keys: Del

Copy
The current range is copied into the Clip but not deleted
in the project. The sample length is not varied. Please
note that the former Clip contents are deleted. The Clip
again has the same attributes as the project.

Toolbar:

Keys: CTRL + c or c

Copy as
The current range of a Wave project is copied into a new
file. A file requester appears to select the name of the new
project.

Insert/Paste
The contents of the Clip are inserted into the current
project behind the position of the play cursor or the be-
ginning of the currently selected range. The data that are
located behind the insert position are moved out of the
way to make room for the Clip contents. The samples or
audio tracks become longer. The Clip remains unchanged
during the procedure. If the Clip was empty, an error
message is displayed.
After inserting the contents, the program selects a range
over the inserted area. If you select Edit->Delete , the in-
serted contents are removed and the project is returned
to the original state.

The following table shows how MAGIX® Music Editor
responds in the case the clip and the project have differ-
ent channel numbers:
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Clip Project Clip Channel Project Channel
Mono Mono Channel 1 Channel 1
StereoStereo Channel 1 Channel 1

Channel 2 Channel 2
Mono Stereo Channel 1 Channel 1

Channel 1 Channel 2
StereoMono Channel 1 Channel 1

Shortcuts:
Toolbar:

Keys: CTRL +v or v

Overwrite with Clip
The current range is replaced with the Clip contents. The
overall sample length remains unchanged. The data that
occupied this position before cannot be recalled. The Clip
contents are not changed. The assignment of the Clip
channels follows the table mentioned above.

Keys: Alt +v or Insert Key

Extract Range
This function is the counter part of the ‘Cut’ function.
The current range remains unchanged only the sections
before and after the selected range are permanently de-
leted. The audio file becomes shorter. The contents of
the Clip are unchanged.

Mix with Clip
The range contents and the Clip contents are mixed. Chan-
nel assignment between project and Clip follows the ta-
ble above (See ‘Insert’ function). The contents of the Clip
are not altered.
Since either component is combined with their full sam-
ple values, make sure that no over-modulation takes place.
This function is performed by way of addition. This as-
sures on one hand, that the project sample remains free
of a sudden volume decrease. On the other hand, modi-
fication of the amplitude might need to be performed
before the mix to keep the resulting sample from clip-
ping and distorting. For information on amplitude modi-
fication, see ‘Editing Menu.’

Insert Workspace
The ‘Insert Workspace’ option will insert ‘blank’ data at
the current play cursor position or the position of the cur-
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rently selected range. Size and position of the inserted
blank space will depend on the length of the range se-
lected before.
The blank space will actually contain data with zero value.
The data following the insertion point will be added to
the end of the blank space. The defined range is main-
tained, the length of the inserted space extends the over-
all sample.
If you do not have sufficient memory to insert the
workspace, MAGIX® Music Editor will display an error
message.

Crossfade
The section before the current play cursor position or the
selected range is merged with the contents of the Clip in
a way to create a crossfade section. Two separate cuts are
needed:
1) Copy a range into the Clip.
2) Set the play cursor on the desired position and then

call up the crossfading function.

Amplitude / 2
This function divides the amplitude of all sample values
by a factor of 2. The same could be achieved by a fade-in/
fade-out with parameters ranging from 50% to 50%. How-
ever, this function is much faster since computing time
is greatly reduced.

Amplitude * 2
The same holds true for the ‘Amplitude * 2’ function.
However, sample amplitude values are multiplied by a
factor of 2, thus corresponding with a fade-in/fade-out
process with parameters ranging from 200% to 200%.

Append Projects
With this function a project can be appended with an-
other project, i.e. the material of one project is copied di-
rectly behind the material of the first.
You need to first select the project you want to append.
Then you activate the menu and click on the project you
want to add to the first.

Change Bit Resolution
When using this function, MAGIX® Music Editor lets you
select the bit resolution of a Wave project.
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Notes for Working with 8-bit Wave Projects:
Lower resolution audio files are often used for multime-
dia applications. A reduction of the resolution to 8-bit is
useful, since the storage requirements are also reduced.
A drawback of lower bit resolutions is the decline of the
signal to noise ratio (SNR). The quantization noise in-
creases with the lower resolution. The quantization noise
is not of a steady type. In fact, it is modulated by the sig-
nal and appears especially annoying.
By the way, the bit resolution of a project file is always
displayed in the title bar of the project window. Bit reso-
lutions between 1 and 8 bits use 1 Byte (8 Bit) per sample
value. Resolutions between 9 and 16 bits use 2 Bytes (16
Bit).
If you need to perform multiple processing steps on an
8-bit Wave project, convert the audio file into a 16-bit
project before starting the processing. Any calculation
inaccuracies occur in the 16-bit realm and are therefore
minimized. Also, some functions in the Effects menu
only work with 16-bit samples. After your are done
processing the audio, convert it back to an 8-bit audio file.
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Graphic Refresh
Display inaccuracies after complicated sample process-
ing can be fixed by using this menu option. The screen
(window) will be cleared and redrawn to display the project
properly.

Sections
MAGIX® Music Editor allows the optional display of one,
two or three sections of the samples belonging to one
Wave project. Other audio editing applications usually
show only one window of a sample.
If you select ‘2’, MAGIX® Music Editor will display the
same sample in two window sections. Each section can
be handled separately. It is possible, for example, to rep-
resent the complete sample in one section and a zoomed
in version of a certain range in the other.
The mode ‘3 sections’ is especially useful for searching
for loop points in Wave projects.
The whole sample can be shown in the upper section,
while the section on the lower left displays the beginning
of the loop range and the section on the lower right the
end of the range. Use the split range function for this
purpose (key b).
Go back to 1 view with Shift b!
This is only an example of the mode ‘3’ view. All sections
can be handled independently.
You can also drag ranges over the section bounds. Estab-
lish the starting point of a range by clicking, then keep
the mouse button pressed, and change over to another
section. MAGIX® Music Editor will show you the size of
the range and at the desired location release the left mouse
button to determine the end of this range.

Show Grid
This menu function will display the grid on the project
window. The units of measurement defined in ‘Units of
Measurement’ will appear in the upper sections of the
grid.

Keys: #
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Grid Setup
With this option, you can define the type of grid that is
used for the Show Grid option. Select between several
line styles.

Units of Measurement
‘Units of Measurement’ is used to specify the grid dimen-
sions. Several display options are available which will
appear at the upper section of the grid.
The units supplied with MAGIX® Music Editor are ‘Sam-
ples’, ‘Milliseconds’, three SMPTE Frame options, the
MSF format for red book CDs (SMPTE with 75 frames),
SMPTE + Milliseconds (instead frames) and ‘Bars’ for
BPM display.
Note: If you want to find out what the current speed of
the a selected quarter bar is, simply select the ‘Beats’ op-
tion. The upper indicator ‘L:’ will display the BPM.

Snap to Grid
This function switches the Grid on and off.

Toolbar:

Keys: Ctrl + r

Snap Setup
Range: Activates the range grid and enables the use of
the current selected range as grid base (by clicking on the
button ‘Get Range’). This option is very useful if you have
found the perfect location defining a particular music bar
in the sample. To transfer the range into the grid, use the
command ‘Get Range’.

Fixed Bar Snap: Activates a grid, this is based on bars
and beats from the beginning of the project. You can
specify the speed of the measure by entering the BPM
(Beats Per Measure) value in the dialog box. By clicking
on the ‘Bar Options’ button you have more options to
specify the parameters for this option such as the time
signature.

Free Bar Snap: Activates a grid, which is based on bars
and beats. The difference to the ‘Fixed Bar Grid’ option is
that MAGIX® Music Editor takes the number of beats
entered in the dialog box and automatically calculates the
speed from the length and position of the range. If a com-
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plete 4/4 measure is selected the number of beats in the
measure would be 4. The length of the range would de-
termine the speed in BPM that is needed to play the sam-
ple in the selected time frame.

Bar Definitions: This dialog lets you specify the bar
settings, e.g. Numerator / Denominator, the speed in
beats per minute and the timer resolution in peaks per
quarter note.

Keys: SHIFT + r
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Normalize
This function modifies the sample’s overall amplitude.
The data is altered so that the maximum amplitude oc-
curring in a specified range is set to 100% (or any other
value between 1-400%). Music Editor  will first attempt to
detect the maximum and relate it to the percentage cho-
sen. Then all other values are weighted with the new fac-
tor.
The Normalize function is designed to fully modulate or
over-modulate samples. A particular application is
processing that is done before a conversion from a higher
sample resolution to a lower resolution takes place. Since
the dynamic range of the low resolution is smaller, it still
can be fully utilized by applying the Normalize function.
If working with sounds from one single instrument, you
should set the factor to 100%.
If, however, your audio material has background percus-
sion for example, you will be able to over-modulate the
sample to 120% to 200%. This will only cut off the new
percussion peaks. The same method allows you to alter
the sound of natural instruments by over-modulating
them.
As preparation for further physical processing, such as
filters, reverb, dynamic compression etc., a level reduc-
tion of 50-70% is suggested. This should avoid clipping
during post processing.

An important reselect: If the volume level during the
recording is relatively low and the material is later nor-
malized, the result will not be of the same quality if the
recording level is maximized to its fullest range. If for
example the volume level was only set to 50% of the pos-
sible range, the audio material will be in 15-bit quality.
Even normalizing the material to 100% will not change
this aspect.

Keys: n

Switch Channels
With this function you can switch left and right stereo
channel. This is useful to correct recordings with switched
channels.
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DirectX Plug-Ins
This function allows you to use Microsoft DirectX com-
patible plug-ins with MAGIX® Music Editor. This com-
plements the already existing superb effects with an un-
limited number of 3rd-party effects.

Working with the Plug-Ins:
After opening the plug-in dialog, a list of installed DirectX
Plug-Ins is visible. Double clicking on a specific plug-in
moves the plug-in to the left side of the dialog. The left
side shows the active plug-ins. At the same time the plug-
in is moved into the active plug-in list, the dialog for the
chosen plug-in is displayed. The DirectX plug-in dialog
allows you to make further settings for the effect. Addi-
tional double clicks on entries in the right-side list add
other plug-ins to the active plug-in list on the left side.
Please make sure that the chosen plug-ins are compat-
ible with each other. For example, mono and stereo plug-
ins can not be used simultaneously – an error message is
displayed.
The last plug-in loaded into the active plug-in list can be
deleted with the button ‘Delete last Entry’.

Test: This button activates the real-time preview of the
active plug-in listed on the left side of the display. This
function is ideal for testing of the chosen plug-in settings
if the real-time calculation operates sufficiently.

Preview: This function calculates a short segment of the
audio material with the active plug-in settings and plays
back the audio segment. Use this option if your system
does not seem to be able to sustain the real-time preview
(button ‘Test’). The length of the off-line preview can be
determined with the setting System (shortcut: y).

Parametric Equalizer
This dialog contains a 3-band parametric equalizer. You
can activate filters on three freely selectable frequency
ranges to adjust the sound of a sample. You can produce
wide-band frequency adjustments for both high and low
pass ranges as well as small-band corrections of specific
frequency ranges.
To accomplish this you must select an area in the current
project or with the ‘a’ key the entire project.
On faster computers, the real-time preview can be used.
Using the preview, a specific setting can be easily exam-
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ined before it is written back to the sample. On a Pentium
with 90 MHz or higher, all 3 bands can be calculated in
real-time and played back simultaneously!

Frequency: With the frequency faders, the middle fre-
quency of the individual filters can be adjusted between
10 Hz and 24 kHz. Through the free choice of the fre-
quency, several filters can also be set to the same values
to achieve a greater effect.

Width: Here the width of the individual filter can be
adjusted between 10 Hz and 10 kHz.

Decibel: This fader set the amount the filter is increased
or decreased (+/- 20 dB). A fader setting of ‘0’ deactivates
the filter and thus consumes no additional processing
power.

Volume: You can adjust the overall volume with this fad-
ers if due to the filtration of the individual levels the vol-
ume is too low.

Test: This button activates the real-time preview. If the
preview cannot be turned off by pressing the ‘Test’ but-
ton again (due to overload of the computer) press the
spacebar to stop the audio playback. Increase the real-time
buffer size in the menu ‘Setup’, ‘System’ if needed!

Graphic Equalizer
This dialog contains a 5 band graphic equalizer. The fil-
ters can be adjusted on five pre-determined frequency
ranges, to alter the sound of a sample.
To accomplish this you must select an area in the current
project or with the ‘a’ key the entire project.

Equalizer

The frequency ranges can be raised or lowered individu-
ally with the five faders. If you set the fader to the ‘0’
position the filter is deactivated and will not consume any
processing power.

Volume

You can adjust the overall volume with this faders if due
to the filtration of the individual levels the volume is too
low.
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Test: This button activates the real-time preview. If the
preview cannot be turned off, by pressing the ‘Test’ but-
ton again (due to overload of the computer), press the
spacebar to stop the audio playback. Increase the real-time
buffer size in the menu ‘Setup>System’ if needed!

Compressor / Expander
With this Editor (Compressor/Gate/Distortion) you can
work on the dynamics of a sample.
Processing is carried out in the same way as on high-qual-
ity studio equipment ”previewing”, i.e. there is no peak
overriding, or other artefacts, as the algorithm can never
be ”surprised” by peak levels. All of the functions can be
pre-heard in real-time (Test-Button).
The following functions are available:

Compressor/Expander
The dynamics of a work are restricted, loud passages stay
loud, quiet passages become louder. Compression is of-
ten used to give material more power and assertiveness.
The compression level is set with the Ratio Control, the
application level is determined by the Threshold. Build-
up and fade-out times can be influenced by Attack and
Release. An Expander is the functional opposite to the
compressor: the differences between the peak levels and
quiet passages become greater.

Gate
Very quiet passages (under the Threshold Level) are sup-
pressed or drawn down to zero. This effectively enables
the noise level even in the pauses between individual
takes to be suppressed, but even at high compressions
levels (Ratio > 5) the Gate function is useful, to avoid over-
raising of the quietest passages and thereby the back-
ground noise.

Distortion
With this set-up audio material can be distorted by means
of a non-linear transfer identification line; the signal be-
come louder and additional harmony waves are created.
By influencing the application point of the distortion
(Threshold) a soft, analogue sounding distortion (Over-
drive) can be generated (Threshold e.g. on -40 dB), or a
hard, digital sounding distortion (Threshold on 0 dB).
With Ratio the strength of the distortion can be set pre-
cisely.
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Parameters for the Compressor/Gate/Distortion Editor:
Ratio: This parameter controls the strength of the given
effects, 1.0 means no effect.

Threshold: Here the application threshold can be set,
above or below that of the given effect.

Attack: Here the time can be set in which the algorithm
reacts to increasing levels.

Release: Here the time can be set in which the algorithm
reacts to decreasing levels.

Gate Level: This parameter determines under which
amounts the level should be set to 0.

Reverb
This function generates high quality reverb in 3 different
types.

Type: Here you can switch between short, medium and
long reverb.

Mix: This slider lets you adjust the level of the dry signal
and the reverb sound.

Volume: Here you can adjust the output level of the au-
dio material.

Test: This button calculates a short buffer of audio mate-
rial with reverb and starts playback for previewing the
results.

Declipping
Music Editor  contains a function to remove digital or
analog clipping. Anybody who records audio has encoun-
tered this one before. The perfect live recording contains
clipping at the most important moment. This alone may
render the recording unusable!
Music Editor  uses high-grade algorithms to interpolate
the passages containing the clipping. The algorithm uses
the material before and behind the clipping as a refer-
ence point.
The declipping algorithm is especially useful for mate-
rial that contains obvious clipping, such as a piano or voice
recording. Distorted drumbeats are normally not salvage-
able.
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Minimal Level of Clipped Samples: This setting deter-
mines the volume level the algorithm considers offend-
ing material. There are sound cards that exhibit different
clipping behavior and this setting becomes an important
issue. Some DAT recorders have an analog protection
mechanism so that the level never reaches the digital
maximum signal. In these cases a setting of –0.5 dB or
lower make most sense.
By entering a value of –6 dB all samples above half of
the digital maximum are considered ‘distorted’ and are
recalibrated. Even analog distorted material can be im-
proved with the algorithm.

Remove DC offset
This function in menu ‘Effects’ removes a DC offset in
the selected range of a Wave project (RAP or HDP). Some
sound cards produce such a DC offset while recording,
so it is useful, if you can remove it!

Get Noise Sample
This mode uses a noise sample to reduce the unwanted
sound.

Noise Reduction
The Noise Reduction function can be used to effectively
remove annoying noise material from the audio with very
little or almost no discoloration of the original audio. For
this function the algorithm needs an example of the noise
print that needs to be removed. This function works best
with types of noises such as a constant occurrence of a
ground loop, air conditioner, hum, tape hiss or feedback.
Please note that this algorithm was not necessarily de-
veloped to remove pops and clicks from audio material.
However, a typical click noise floor such as vinyl record-
ings can still be successfully treaded with this function.
The algorithm can also work without a noise sample -
then only white noise is reduced, such as tape hiss or
microphone amplifier hiss.
Mark a range over the audio material you want to be re-
duced in the recording! Then create the noise sample be-
fore opening the Noise Reduction dialog using the menu
„Effects > get Noise Sample“ !

Without Noise Sample: Use this mode if you do not
have a noise sample and you only want to reduce white
noise (dehissing).
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Type Noise: Here you can select between different noise
types.

Type Audio: Here you can select between Music and
Voices to control the denoising algorithm.

Absorption: This parameter lets you adjust the level of
noise to be reduced. Please adjust this level carefully - it
controls the quality of the complete noise reduction al-
gorithm! If the level is too low you still hear noise and
artificial high tones. If the level is set too high you may
loose high frequencies of your audio material.

Reduction: Here you can adjust the balance between
original signal and denoised signal. In most cases is is
useful to keep a certain amount of original (non denoised)
material - e.g. with a setting of -12 dB. This keeps as much
of the natural color of the audio material as possible.

Test Realtime: This button starts the realtime preview
function of the actual settings on fast PCs.

Test Offline: This buttons starts the preview funtion for
slower PCs - small parts of audio material are calculated
and played back.

Resampling / Timestretching / Pitchshifting
Important: If you want to change the sample rate of a
whole audio file (e.g. from 48 kHz to 44.1 kHz) please
use the separate function ‘Change Sample Rate’ in the
Effects menu!
All algorithms in this dialog only use the parameter fac-
tor (upper left edit control) to set the amount of effect. All
the other input fields in the parameter group simply con-
trol this factor. This makes it easy to specify the factor by
typing in the new length, pitch or tempo in bpm. Press
‘Refresh Display’ to calculate the actual factor if needed!
The following algorithms can be used:

Resampling: When using a factor lower than 1.0 the
material becomes faster and higher. This is very similar
to an analog tape deck, which runs at a higher or lower
speed. Also samplers and pcm-synthesizers use this type
of algorithm for transposing the samples or waveforms.
Use this mode to correct the pitch and speed of any audio
material, which may change its length.
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If the factor is lower than 1.0, the re-sampling process is
performed without a quality loss.
Otherwise, the re-sampling process will result in a loss
of high frequencies. If for example the length of a 44.1
kHz sample is doubled, the resulting frequency response
of the processed sample is limited to 11.025 kHz.

Pitch Shifting

The pitch of the sample is changed, maintaining the
length. Use this mode to transpose an audio object with-
out changing the length.

Time Stretching

The length of the sample is changed, maintaining the
pitch. Use this mode for example to change the tempo of
a drum loop without changing the pitch.
Time Stretching and Pitch Shifting are no loss-less pro-
cedures - depending on the factor there can occur short
delays or other artifacts in the sample. To minimize these
artifacts you have the choice between 3 internal algo-
rithms:
Loops / Songs: Use this mode for factors in the range of
0.9...1.1. This algorithm keeps the original phase even of
stereo material, but it produces more artifacts when us-
ing with large factors.

Loops / Songs / Speech: This mode uses a much more
complex algorithm, which needs more time that is calcu-
lating. But it gives in most cases better results when us-
ing large factors. The phase of the material is changed to
get a ‘smoother’ sound. If you were for example dealing
with speech, vocals, or orchestral instruments this would
be no problem. More complex spectrums, such as a mix
of different instruments or completed mix problems, may
develop problems.

Solo Instruments: This mode uses the same algorithms
as the last one, but uses more of the smoothing compo-
nent. This makes it ideal for solo instrumental sounds
like piano samples or vocals.

Beat Marker-Mode: This is a additional Timestretch
Mode. It is made for pure Drumloops.
Basically it works like this:
Through activating the option “Find Beat Marker” the
algorithm tries to find and mark Beats in the Audio ma-
terial.
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Only these points will be used for timestretching by mov-
ing the autio material at the markers ahead or back.
Increasing the tempo will superimpose some beats, slow-
ing down generates short pauses between the beats.
That mostly sounds better than the older algorithms.
A threshold value for beat detection can be set by using
the sensitivity control.
Furthermore you are able to set the beat markers manual
before you open the Timestretching dialog.
Just set the markers short of the beats (key: shift + 1 ... 0 )
If a Wave Project is open and visible, you can follow the
process of setting beat markers on the screen.

Test Realtime: This is a new function for the beat marker
mode. Herewith it is easy to test the effect before you let
Music Editor calculate the whole sample.
Irrespective of the tempo, the pitch of the loop can be
adjusted using the pitch control in the upper left region
of the dialog.

Change Sample Rate
Use this function to change the sample rate of a whole
audio file. This may be needed to convert a DAT record-
ing at 48 kHz to 44.1 kHz for use on an audio CD.
After choosing the new sample rate you can select a
filename for the new project.
If the resolution is increased the sample rate change will
take place without any quality loss - the sample material
will not experience fidelity reductions. (The needed hard
disk space will increase though.)
If the resolution is reduced, the overtones or high fre-
quencies may be lost during the sample rate change. For
example, if the resolution of a 44.1 kHz sample is reduced
to 22.05 kHz, the frequency response of the resulting sam-
ple is reduced to 11.025 kHz. The frequency response is
always half of the resolution specified. For a conversion
from a 48 kHz sample to 44.1 kHz, this loss in quality is
not significant, since the human ear only recognizes fre-
quencies up to 20 kHz. (A resolution of 48 kHz is often
only used because the digital to analog conversion can
take place with much higher precision without expensing
a lot of effort.)
Please note that resampling to 44.1 kHz can also be done
while recording in real-time.
The Playback Parameter window (Shortcut: p) contains a
Varispeed option for real-time resampling during play-
back. The Record window (Shortcut: r) will let you
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resample to 44.1 kHz in real-time from any of the selected
sampling rates.

Fade in/out
This function allows sample ranges to be faded in or out.
The amplitude is varied in its time characteristic from the
start value of the beginning to the final value at the end
of the range. When the function has been called, a win-
dow appears in which you can specific parameters for this
operation.
A simple fade-in operation would be performed with the
parameters from 0% to 100%, whereas normal fade-out
requires the specification from 100% to 0%.
The fade curve can be adjusted from linear to exponen-
tial or logarithmic.
Notice that real time fading is applied to virtual projects
only (with handles). For all other projects (RAM and HD),
the sample data is physically altered.

Keys: f

Set Zero
Sample data values in a selected range are set to zero (no
data). Noise and imperfections in a sample can thus be
eliminated.

Invert Phase
The sample data within the selected range is inverted
along the amplitude axis. This phase inversion means that
negative values become positive and vice versa. This func-
tion, too, is reversible.
The ‘Invert’ function permits samples with different
phases to be matched.
Along with the available mixing functions (which are,
from a mathematical viewpoint, adding functions) you
can actually subtract samples by applying this function
to the selected sample.

Revert
The sample data in the selected range is reversed along
the time axis. The playback of the sample data happens
from the end to the beginning. This allows for very inter-
esting effects, not to mention the ‘hidden messages’ fre-
quently referred to in various songs.
This function is reversible: if you do not select a new
range, calling this function once more leads to the origi-
nal material.
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Echo
Music Editor  allows you to apply an echo effect to the
selected range in the Wave project.

Echo/Delay: This section will determine the length of
the echo delay.

BPM: You can specify a particular BPM speed if the echo
needs to run in sync with the audio material. For exam-
ple, if a music piece is set at 110 BPM you could specify
the same setting here and have the delay appear with the
exact beats of the music.

Millisec: Specify a setting in milliseconds for the delay.
1000 ms: This will select a preset of 1000 ms for the de-
lay.
500 ms: This will select a preset of 500 ms for the delay.
200 ms: This will select a preset of 200 ms for the delay.

Echo Decay in %: This parameter specifies the volume
decrease between the single echo events in percent. Val-
ues close to 100% results in a slower echo delay. Values
below 40% lead to rapid decay.
95 %: This will select a preset of 95%.
80 %: This will select a preset of 80%.
50 %: This will select a preset of 50%.

Echo Mode: The Echo Mode setting will determine the
type of delay you would like to apply.
1 Delay (only in mixer mode)
Only one delay will occur in the audio material.

Build Physical Loop
This function utilizes a complex algorithm for optimizing
loops in Wave projects. It is useful when samples are to
be used for instrumental sounds as well as wave table
synthesizer.
Before you can process a sample you need to select a range
in your sample that already defines the rough edges of
the sample loop. Remember that you can shift and vary a
range during playback to find the best loop position. A
comfortable way to look at the loop positions is by acti-
vating the split range mode by pressing ‘b’. The sample
will be displayed in 3 sections.
To gain an interruption-free loop the outer limits of the
range will be set to zero. By applying a crossfade to the
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material at the loop end containing the sample data in
front of the loop beginning, Music Editor  will create a
‘smooth’ transition between loop end and loop beginning.
When a marker is set in front of the selected range, the
range between the marker and the beginning of the loop
will be used for the crossfade. This offers you a feature
found in professional hardware samplers. To achieve a
short crossfade set the marker close to the loop begin-
ning. To receive a long crossfade position the marker fur-
ther away from the loop beginning.
Notice that the distance between marker and beginning
of the loop range needs to be smaller than the loop range
itself to make a crossfade possible.
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Range all
The range will cover the complete sample. This command
comes in handy if you want to apply changes to the en-
tire sample with functions that normally only address
certain ranges.

Keys:  a

Move Play Cursor > to beginning
Sets the start position of the play cursor to the beginning
of the project.

Keys:  Home

Move Play Cursor > to end
Sets the start position of the play cursor to the end of the
project.

Keys:  End

Move Play Cursor > to range start
Sets the start position of the play cursor to the beginning
of the currently selected range.

Keys:  Alt + cursor right

Move Play Cursor > to range end
Sets the start position of the play cursor to the end of the
currently selected range.

Keys:  Alt + cursor left

Edit Range > to beginning
The beginning of the range will be extended toward to
the beginning of the project.

Keys: SHIFT + Home

Edit Range > to end
The end of the range will be extended toward the end of
the project.

Keys:  SHIFT + End



42

Menu Range

Edit Range > Flip Range left
The current range is shifted left by the length of the range.
Its end will be its former beginning. If there is not enough
room to place the range, the command will not be ex-
ecuted.

Keys:  CTRL + SHIFT + left

Edit Range > Flip Range right
The current range is shifted right by the length of the
range. Its beginning will be its former end. Keep in mind
that if there is not enough room to place the range, the
command will not be executed.

Keys:  CTRL + SHIFT +right

Edit Range > Beginning of Range > 0
This function shifts the beginning of range to the right
of the next zero position. The function can be called from
the keyboard by pressing the left Shift + Alt keys and ‘6’
on the numeric keypad at the same time. You can also
press the PgUp key.

Keys: Page Up

Edit Range > End of Range > 0
This function shifts the end of the range to the right of
the next zero position (change in polarity). ‘Zero position’
is the next sample value with zero value or the boundary
between a positive and a negative sample value (or vice
versa). This is particular useful for searching for loop
points. The function can be called from the keyboard by
pressing the right Shift + Alt keys and ‘6’ on the numeric
keypad or the PgDn keys.

Keys: Page Down

Edit Range > Beginning of Range < 0
This function shifts the beginning of the range to the
left of the next zero position. The function can be called
from the keyboard by pressing of the left Shift + Alt keys
and ‘4’ on the numeric keypad. You can also press the
PgDn key.

Keys: SHIFT + Page Up
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Edit Range > End of Range < 0
This function shifts the end of the range to the left of the
next zero position.
The function can be called from the keyboard by simul-
taneously pressing the right Shift + Alt keys and ‘4’ on
the numeric keypad or by pressing the Shift + PgDn keys.

Keys: SHIFT + Page Down

Edit Range > Range length to
This command lets you set the range length to 1, 2, 4, 8,
and 16 bars. You can set the tempo in BPM with menu
View->Snap Setup.

Split Range
This function is in particular useful for working with
loops. If not already displaying in Split Range Mode the
project is first switched to this mode displaying three sec-
tions on the screen.
The upper section displays the whole sample. The sec-
tion located at the bottom left displays the data near the
beginning of the range. The section at the bottom right
displays the data near the end of the range.
The boundaries of the range can be exactly positioned in
the lower sections, while the upper section will display
the location of the entire range. You can also define ranges
across several sections.

Keys:  b

Store Range
Another powerful feature of Music Editor  is the option
of defining and saving different ranges for future re-
trieval. An unlimited number of ranges can be defined.
You can for example specify different loops and compare
them while you recall their ranges.
All ranges of a project can be seen in menu Tools->Range
Manager. There all ranges can be renamed or played.
When selecting this menu option, the selected range
needs to be stored by entering a numerical value the range
is associated with.

Keys: SHIFT + F2 ... F10
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Store Range > Other
You can define more ranges by using the submenu
‘Other’.
You will need to specify a name for the range selected.

Keys: SHIFT + F11

Get Range
By selecting this option, you can choose one of the de-
fined ranges as the current range.
Music Editor  even lets you choose a range while playing.
The specified range becomes the current one and is audi-
ble. Using this method, you can change between two
ranges comparing them with each other. Ranges can also
be named and recalled with the Range Manager (Tools
menu).

Keys: F2 ... F10

Get Range Length
By selecting this option you can choose the length of one
of the defined ranges as the current range.
Music Editor  even lets you choose a range length while
playing. The specified range becomes the current one and
is audible. Using this method you can change between
two range length comparing them with each other.

Keys:  Ctrl + Shift + F2 ... F10

Store Marker
You can store an unlimited number of markers wherever
the play cursor is placed at.

Keys: SHIFT + 1 ... 0

Using the submenu ‘Other’, you can define more mark-
ers with a desired name. Defined markers can be seen
above the sample data section of the project window and
can be moved with the mouse.

Keys: SHIFT + [
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Store Real-time Marker
With this function (Alt + number key) markers can be
stored during playback. The markers are dropped at the
current play cursor position. This allows you to ‘mark’ up
your project for later editing.

Keys: ALT + 1 ... 0

Get Marker
By selecting this menu option, you can easily locate
marker points. Simply specify the desired marker loca-
tion and Music Editor  will position the play cursor at that
location.
You can even select a new play cursor location during
playback of the project.
You should keep in mind that, whenever a marker has
been defined, the range between the marker and the end
of the sample is played.

Keys: 1 ... 0

Markers on Range Borders
This function sets two markers to the beginning (S) and
the end (E) of a selected range.

Set Markers on Silence
This function sets markers on silent regions in the sam-
ple (only in Wave projects - HDP or RAP). You can choose
the minimal length of the pause, a threshold level, the
start number and a prefix for the marker name.
This is very useful to select the regions of sample CDs
etc...

Get last Range
This function restores the last range that was selected. It
comes in handy when a range was mistakenly deleted by
a mouse click.

Range Editor
The beginning, the end and length of a selected range
can be numerically changed in different units of meas-
urement. This function will let you specify minute de-
tails of a particular range you need to set.
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If you change any of the values in the ‘Range Start’, ‘Range
Length’ or ‘Range End’ sections, all other values will au-
tomatically be updated with the exceptions below:
Change values in the Range Start section:
The end will be maintained.
Change values in the Range End section:
The start will be maintained.
Change values in the Range Length section:
The start will be maintained.
Please note the format of the ‘Bar’ dialog box. The for-
mat is displayed as a 4/4 beat with 96 clicks per quarter.
Displayed are the bar, beat, and clicks.
The number of beats per minute (BPM) can be set in the
BPM dialog box in View->Snap Setup.
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Cascade
This function arranges all open windows in a cascade
style.

Tile
All open windows are moved next to each other, making
use of the whole display area.

Keys: Return/Enter

Untile
This function will return the window order to the previ-
ous state.

Keys: Shift + Return.

Arrange Icons
All icons are rearranged along the lower portion of the
screen.

Toolbar
Shows or hides the upper tool bar.

Statusbar
Shows or hides the status bar on the lower portion of the
display.

Positionbar
Shows or hides the positioning bar on the lower portion
of the display.

Rangebar
Shows or hides the range bar on the lower portion of the
display.

Time Display
Shows or hides the time display window.
This window always shows the actual time position in
the actual format.You can change this format with the
menu ‘Units of Measurement’. We recommend the
SMPTE format: hours:minutes:seconds:frames. The
colors and the font for the display can be changed in the
File->Preferences. You can zoom the window to any size
and position it anywhere on the screen!
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Osci / Correlation
A simple oscilloscope view can be opened to display the
wave form in a scaleable window. When activating the
Phase checkselect the phase correlation of a stereo signal
can be displayed.
A vertical line represents a mono signal, a horizontal line
represents a signal with a phase invertion, which is not
wanted in most cases.

Transport-Control
With the new transport control you can easily start and
stop playback, start record and punch recording.
Also the cursor position and range langth can be seen in
the transport control.
An output peakmeter is shown in the lower line.

Control Elements:
Play: Here you can read the play or rnage start position

L: This shows the langth of the actual range.

E: This shows the end position of the marked range

Scroll bar: This lets you move the play cursor through
the project.

Play Parameter
The Play Parameter window which appears after select-
ing this menu option is designed to quickly enter play-
back parameters. Below is an explanation of the options
available in this window.

Sample Rate: The sample rate can be changed here as
long as the soundcard supports the new rate (some
soundcards even support changing the rate while play-
ing the sample!). This is especially useful to hear notes
in a sample range played in a different octave. When se-
lecting half the sample rate the pitch should be the same.
It would be played one octave lower.
Device - To specify the driver of the sound card use this
dialog box. This is especially important if multiple out-
put devices are located in the computer.
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Autoscroll: The ‘Autoscroll’ section will let you activate
the autoscroll feature. It is especially useful when work-
ing with long disk files. The HD Wave project window
will follow the play cursor during playback.
When working in ‘2’ or ‘3’ section display mode, the
autoscroll feature will cause the individual sections to
follow the play cursor as well. If you have zoomed into
one of the sections, the play cursor will move through
the section faster resulting in more screen redraws.
There are two alternatives in auto scrolling.
The ‘Soft’ option performs a smooth scrolling of the whole
waveform, the play cursor stays in the center of the dis-
play. This mode needs a fast graphics board, because the
complete screen is scrolled between the marker steps.
The ‘Page’ option performs a page by page scrolling.
Please note, that the auto scrolling requires certain
processing power based on your processor, graphic card
and the resolution of the display. For this reason you
might encounter small interruptions in playing the au-
dio files. Should this occur simply disable the auto scroll
feature or raise the buffer size (select ‘Setup’ menu and
click on ‘System’).

Scrubbing: While pressing the 0 key on the numeric
block (Numlock active) and moving the mouse you can
perform scrubbing. MAGIX® Music Editor starts playback
at a very low speed, the mouse position relative to the
start play cursor controls the speed.
There are two scrubbing modes (in playback parameter
window - key p):
Note: When working with smaller buffer sizes (4000,
2000 samples) the scrolling becomes 'softer'. Please
verify the performance of your computer system and
smaller buffer sizes to not produce playback interruption.

Relative: The distance between the play cursor and the
mouse sets the playback speed.

Absolute: The position of the mouse in the window sets
the playback speed - at the left border
playback speed is 200% backward, at the right border
speed is 200 % forward, in the middle of the window the
speed is 0.
There is a real time resampling performed for changing
the playback rate without changing the sample rate of
the sound card. For best performance, use small play
buffer sizes and a fast processor.



50

Menu Window

A Tip Using Scrubbing: The scrolling becomes ‘softer’
when using small buffer sizes (2000, 4000 samples). You
may need to test your system for error free playback with
these small settings. Combined with the Soft Scroll mode,
editing becomes very convenient on faster computers

Varipitch: MAGIX® Music Editor supports smooth
changes of the pitch while playback, even in multi track
projects (vertical slider in playback parameter window -
key p).
Activate the Varispeed mode with the ‘active’ button, then
you can change the playback speed in various kinds:

Vertical slider: Changes the playback speed from -200%
to +200%

Pitch Factor: Lets you specify a certain pitch factor
manually

Halftones: Lets you specify a value of halftones. The
playback will be transposed the number of halftones.

Internal Rate: Here you can set a sample rate for the
varipitch calculation. If you want to play a WAV file with
a sample rate of 48 KHz but your sound card can only
play rates up to 44.1 KHz simply set the internal rate to
48 and activate varispeed. You hear the same result as
playing back with real 48 KHz!
This function is also very useful for digital playback to
DAT with 44.1 KHz samples and and vice versa!

BPM: Here you can type in the original bpm value of your
material and a destination bpm value, which is reached
using the varipitch.
Important: Varipitch works also while recording! So you
can set the pitch to -2 halftones, sing a song into the com-
puter, then switch off the varipitch - your track is trans-
posed two halftones higher!
There is a real time resampling performed for changing
the playback rate without changing the sample rate of
the sound card. For best performance use small play
buffer sizes and a fast processor (Pentium recommended).

Keys: p
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Close all Windows
Closes all opened projects. Before closing a window/
project, MAGIX® Music Editor will ask you whether you
would like to save the project.

Half Height
The MAGIX® Music Editor screen is shown in the upper
half of the display.
This is useful, when using a sequencer program in
multitasking. So you can switch between MAGIX® Mu-
sic Editor and the sequencer without the need of com-
plete screen redraws.

1, 2, ...
Choose active window from the list.
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This menu contains the context sensitive online help
functions of MAGIX® Music Editor and the about box.

Contents of Help...
Use this command to show the contents of the help sys-
tem. Click the command, for which help is needed!

Context Help
Use this command, to get help about any part of MAGIX®

Music Editor. Click the button in the upper

toolbar and then click on any button or menu item to get
the help information.

About MAGIX® Music Editor...
Copyright notices and version numbers are displayed.

System Information
A window is displayed, containing information about the
memory status and other parameters.
Particularly useful is the display of the free storage on all
connected disk drives, the used system resources utilized
by MAGIX® Music Editor and the memory usage. Make
sure the parameter for system memory used by MAGIX®

Music Editor never grows larger than the displayed over-
all system memory available (physical RAM). If this hap-
pens, the performance of MAGIX® Music Editor is re-
duced caused by page swapping (virtual memory) done
to compensate for the missing memory.
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A few Tricks

A few tricks that help make working with MAGIX® Mu-
sic Editor easy:

Working in Projects
– The ‘a’ key will select the complete sample as a range.
– With the keys Home and End you can set the play cur-

sor to the beginning or end; all selected ranges will
disappear.

– A range can be selected from one exact marker posi-
tion to the next by clicking on the marker above the
waveform. Next, hold the Shift key and click on the
second marker.

– Using the Shift + mouse click a range can be moved
horizontally.

– Shift + Ctrl + Cursor keys will flip a range to the right
or left. This is a great way of testing a loop at a differ-
ent position.

– To determine the tempo of a selected range (BPM),
open the Snap Definition dialog (Shift + ‘r’) and select
the number of beats the selected range represents (for
example: 4) in the Section ‘Free Bar Snap’. Next, click
on the button ‘Get Range’ in the section ‘Free Bar Snap’
to retrieve the length of the selected range. The BPM
display in the ‘Fixed Bar Snap’ section now displays
the BPM of the audio section.

– The ‘Delete’ key deletes markers when the Play Cur-
sor (real-time cursor) is located exactly on the marker.

– When pressing the ‘Return’ key, all open windows are
tiled on the MAGIX® Music Editor screen.

Recording/Playback
– The Recording window can be displayed by pressing

the shortcut key ‘r’. The recording can be started with
the key ‘r’ and stopped with the key ‘s’ when the Re-
cording window is displayed and active.

– The playback can be started and stopped with the
Spacebar. When stopping, the Play Cursor returns to
the original position. If the playback is stopped with
the ‘0’ key on the numeric keypad, the cursor will stop
at the current playback position. Continuing to hold
the ‘0’ key, while moving the mouse (Scrubbing) can
alter the exact position.
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Upper toolbar

    1     2       3      4     5       6       7      8

1 Open WAV File
2 Save Project
3 Cut Range
4 Copy Range
5 Insert Range
6 Snap on/off
7 Transport Control
8 Context Help Mode

Lower toolbars
Sections can be defined by the button bars located on the
bottom part of the screen and by proportional bars located
on the bottom and right edge of the window.

Position toolbar

1 Section to beginning
2 Section one length left
3 Section half of its length left
4 Section half of its length right
5 Section one length right
6 Section to end
7 Range to last marker
8 Range to next marker
9 Zoom in horizontally
10 Zoom out horizontally
11 Show entire project
12 Zoom from range
13 1:1 presentation
14 Set the zoom depth to 0.1, 1, 10 and 60 seconds
15 Zoom in vertically
16 Zoom out vertically
17 Show complete sample vertically
18 Zoom in to vertical range borders

    1      2    3     4     5     6      7       8      9    10  11    12    13              14                   15    16   17    18
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Range toolbat

    1      2      3     4       5      6      7     8      9

1 Play Cursor on left range border
2 Play Cursor on right range border
3 One range length left
4 One range length right
5 Range start to previous zero crossing
6 Range start to next zero crossing
7 Range end to previous zero crossing
8 Range end to next zero crossing
9 Range Editor
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Keyboard Shortcuts and Intellimouse

You may change the default shortcuts at any time with
“File->Preferences->Keyboard Shortcuts”.

General
A Range all
Ctrl-A Redo
B Split range into 3 views
Shift-B Display gets 1 view
C or Ctrl-C Copy range
Shift-C Copy As
F Fade In/Out
H Close all Windows
I Project Information
Ctrl-I Import Sample
N Normalize
P Play parameter
R Record Dialog
Ctrl-R Grid on/off
Shift-R Grid definition
Q switch Grid off
S Save project
Shift-S Save project with new name
Ctrl-V or V Insert Clipboard
W Load wave
X or Ctrl-X Cut range
Y System preferences
Ctrl-Z Undo
Space Playback on/off
Enter Arrange windows
Esc Abort playback, recording and physical

sample manipulations
Del Delete range
Backspace Restart Playback
Insert Overwrite with Clip
+ Ctrl Copy into Clip
+ Shift Insert Clip
Numeric 0 Scrubbing
Numeric ‘,’ 2 Views
# Switch Grid on/off

Range
Cursor left or
4 on numeric pad: Scrolling left
+ Ctrl Zoom In
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+ Alt Play Cursor to beginning of the

range
+ Shift + Ctrl Flip range left

Cursor right or
6 on numeric pad: Scrolling right
+ Ctrl Zoom Out
+ Alt Play Cursor to end of range
+ Shift + Ctrl Flip range right

HomePlay Cursor to beginning of project
+ Shift range to beginning of project

End Play Cursor to end of project
+ Shift Range to end of project

PgUp Range start to next zero crossing
+ Shift Range start to previous zero

crossing

PgDn Range end to next zero crossing
+ Shift Range end to previous zero

crossing
/ * -
 + Keys on numeric pad: Move range borders depen-

dent on zoom level

Function keys
1-10 Get range 1-10
1-10 + Shift Store range 1-10
+ Shift + Ctrl Get range length
F11 Store range with new name
Keypad 0-9
(not numeric block!): Get Marker 1...10
+ Shift Store Marker 1 bis 10
+ Alt Store Marker while playback
? Store Marker with new name

Microsoft™  Intellimouse
Middle mouse click: Playback Start/Stop
Wheel: Scroll horizontally
+ Ctrl Zoom In/Out horizontally
+ Shift Zoom In/Out vertically
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Problems & Solutions

First of all: A general and fundamental solution. Make
sure that your system and software is installed properly.
Are all needed devices switched on? Are all cable connec-
tions leading from the correct outputs to the correct in-
puts? The most trivial problems often result in the big-
gest frustration.

I see markers with the letter ‘E’ in my physical audio
file and interruptions occur at those spots. What are
they?
Music Editor creates these markers automatically if dur-
ing the recording the program runs out of resources and
recording interruptions take place. This can happen if the
computer is overloaded or not fast enough. Look at the
‘pops and clicks’ section for some solutions to the prob-
lem.

I have pops and clicks in my material when I play
back any audio.
Pops and clicks can sometimes occur with certain sound
cards and system configurations. If it happens, it is most
often during the recording of audio tracks.
Especially when using Music Editor in Windows 95 there
are several things that can be done to remedy the prob-
lem:
Make sure you use the latest driver for the sound card.
You might need to contact the manufacturer of your
sound card for an updated driver.
Check to see that there are no IRQ or DMA conflicts with
other devices in your system. The Device Manager in the
Control Panel in Windows 95 might help you diagnose
problems.
The audio caching setting in Windows 95 might need to
be adjusted. To do this bring up the Control Panel and
select Multimedia from the options. Next, click the Ad-
vanced tab and select the Media Control Devices option.
In the Media Control Devices look for Audio Control
Device and call up the Properties. The following setting
can be adjusted to solve some pops and clicks problems.
Some problems with pops and clicks can be solved by
editing the SYSTEM.INI file in the Windows directory.
Look for a [Vcache] section and add the following lines:

maxfilecache=4096
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This should effectively solve the problem. The values for
the parameters are Kbytes of file cache and can be ad-
justed depending on your RAM size.
By disabling virtual memory a problem with pops and
clicks or other playback or recording problems can some-
times be solved. Please refer to your Windows manual
for instructions on how to disable the virtual memory.
As a rule of thumb: If the status bar in Music Editor does
not indicate any errors during playback or recording, the
problem most likely has to do with the sound card driver
or settings for the sound card.

I get no audio during recording or playback.
If you hear no audio during either recording or playback
in Music Editor, check on the following items:
Make sure that all cable connections are made properly
and that none of the cables is defective.
If the sound card has a mixer program, make sure that
none of the mute options are turned on and that the vol-
ume faders are sufficiently turned up.
Check to see whether you have the proper driver installed
for your sound card. You can do this in the Windows
Control Panel.
If you don’t hear any audio in Music Editor and would
like to check your sound card, use the sound card’s own
sound utilities to diagnose the card. Also, many sound
cards come with their own set of playback software for
digital audio. Follow the instructions in the sound card’s
manual for testing digital audio with the card’s utilities.
Make sure that your external mixer/amplifier is turned
on and has a sufficient volume setting.
These are the most common problems you would be deal-
ing with when having audio problems.
Note: The Digital Audio Labs CardD+ approaches moni-
toring the recorded signal during the recording a little bit
different than other sound cards. It is perfectly normal to
have the incoming audio signal missing on the outputs
of the card as you are recording the audio.
The CardD+ will not ‘feed’ the audio signal on the inputs
of the card to the outputs during the recording. You will
need to monitor the recorded signal externally during the
recording phase. All other tracks in Music Editor will play
back just fine.
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Whenever I start playback or recording my system
hangs or displays an error message.
This many times is an indication that an IRQ or DMA
and possibly an address conflict is present. You will need
to make sure that no other component in your computer
system uses the same hardware settings as your sound
card. If it does, the system may hang or even crash.
Under Windows 95 and NT 4.0 you may use the Device
Manager to find free IRQ, DMA and address settings.
Refer to your Window manual for instructions on using
the Device Manager to diagnose your system. There are
also a number of commercial diagnostics tools available
that may assist you with finding free settings. In some
cases reconfiguration of already existing components is
necessary and sometimes even replacing components with
ones that allow you more configuration choices.

Support

If you are unable to correct your problem with Music
Editor  contact  MAGIX® support:

U.S.A.
Info: info-usa@magix.com
Webpage: http://www.magix.com
Fax: (310) 656-0234

Europe
Info: info@magix.com
Webpage: http://www.magix.com
Fax: ++49 - (0)89-7691041
T.: 0181 968 1554
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Index
AAAAA

Absolute  49
Absorption  35
Active Section when using Zoom Levels  8
Add Drive  13
Alias  14
Append Projects  24
Arrange Icons  47
Attack  33
Autoscroll  49

BBBBB

Bar Definitions  28
Beat Marker-Mode  36
Beginning of Range < 0  42
Beginning of Range > 0  42
BPM  39, 50
Buffer Number  19
Build Physical Loop  39

CCCCC

Cascade  47
CD ROM Drive Configuration Dialog  13
Change Bit Resolution  24
Change Sample Rate  37
Changing a Range  9
Check the Spacebar for Playback  19
Clip  10
Close all Windows  51
Configuration  13
Contents of Help...  52
Context Help  52
Copy  22
Copy As  22
Copy Mode Burst  14
Copy Mode Normal  14
Copy Mode Sector Synchronization  14
Copy selected Track(s)  13
Corel/Osci  17
Crossfade  24
Cut  21
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Index
DDDDD
De-Selecting a Range  9
Decay  39
Decibel  31
Declipping  33
Delete  13, 22
Delete Wave project...  15
Deselect tracks  13
Device  16
Differences between Mono  and Stereo Wave
Projects  11
DirectX PlugIns  30
Disk Space  17
Distortion  32
Drive List Dialog  12
Drive Name  13

EEEEE

Echo  39
Echo Decay in %  39
Echo Mode  39
Echo/Delay  39
Edit  21
Edit Range  41, 42, 43
Effects  29
End of Range < 0  43
End of Range > 0  42
Equalizer  31
Exit  20
Expander  32
Export Sample  16
Extract Range  23

FFFFF

Fade in/out  38
File  12
Fixed Bar Snap  27
Flip Range left  42
Flip Range right  42
Free Bar Snap  27
Frequency  31

GGGGG

Gate  32
Gate Level  33
Get last Range  45
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Index
Get Marker  45
Get Noise Sample  34
Get Range  44
Get Range Length  44
Graphic Equalizer  31
Graphic Refresh  26
Grid Setup  27

HHHHH

Half Height  51
Halftones  50
HD Record Buffer  19
HD Wave Buffer  19
HD Wave Projects  18
Help  17, 52
Host Adapter Number  13

IIIII

Im/Export  18
Import Sample  15
Insert Workspace  23
Insert/Paste  22
Internal Rate  50
Invert Phase  38

LLLLL

Load CD Track(s)...  12
Load Setup  13
Loops / Songs / Speech  36

MMMMM
Marker  10
Markers on Range Borders  45
Millisec  39
Minimal Level of Clipped Samples  34
Mix  33
Mix with Clip  23
Monitor  17
Mono Wave Project  11
Move Play Cursor  41
Moving a Range Horizontally  9
Moving of Ranges in Small Increments  9

NNNNN
New (Button 1)  17
Noise Reduction  34
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Index
Normalize  29

OOOOO

Open Project  12
Osci / Correlation  48
Overwrite with Clip  23

PPPPP

Parametric Equalizer  30
Pitch Factor  50
Pitch Shifting  36
Play  13, 48
Play Cursor  11
Play Parameter  48
Play/Record Buffer  19
Plug-Ins  30
Position toolbar  54
Positionbar  47
Preferences>Colors  20
Preferences>System  18
Preferences>Undo Definitions  20
Preview  30
Preview Time  20
Problems & Solutions  58
Properties>Project Information  18
Properties>Text Comments  18

QQQQQ

Quickstart  7

RRRRR

Range  8, 27, 41
Range all  41
Range Editor  45
Range length to  43
Range to end  41
Range toolbat  55
Rangebar  47
Ratio  33
Real Time Buffer  19
Record  7, 16, 18
Record Mode  16
Record Time  17
Recording/Playback  53
Redo  21
Reduction  35
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Index
Relative  49
Release  33
Remove DC offset  34
Rename Project...  15
Resample / Timestretching  35
Resampling  35
Resampling:  35
Reset  13
Resume  13
Reverb  33
Revert  38

SSSSS

Sample Rate  16, 48
Save in Format  15
Save Project  14
Save Project as...  14
Save Setup  13
Saving Ranges and Special Range Commands  9
Scroll bar  48
Scrubbing  49
SCSI-ID  14
SCSI-LUN  14
Section  8
Sections  26
Sectors per Read  14
Select all tracks  13
Selecting a Range  9
Set Marker 1  18
Set Markers on Silence  45
Set Zero  38
Show Grid  26
Snap Setup  27
Snap to Grid  27
Solo Instruments  36
Split Range  43
Split Range for Video  43, 44
Statusbar  47
Stereo Wave Project  11
Stop  13, 18
Store Marker  44
Store Range  43, 44
Store Real-time Marker  45
Support  60
Switch Channels  29
Sync Sectors  14
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Index
System information  52

TTTTT

Terminology and Editing Concepts  8
Test  30, 31, 32, 33
Test Offline  35
Test Realtime  35, 37
Threshold  33
Tile  47
Time Display  47
Time Stretching  36
Toolbar  47
Track List (Copy, Play)...  12
Track List Dialog  13
Transport Control  48
Type  33
Type Audio  35
Type Noise  35

UUUUU

Undo  21
Units of Measurement  27
Untile  47

VVVVV

Varipitch  50
Vertical slider  50
View  26
Volume  31, 33

WWWWW
WAV (*.wav)  12
Wave Projects  11
Width  31
Window  47
Without Noise Sample  34
Working in Projects  53
Working with 8-bit Wave Projects  25

ZZZZZ
Zoom  7, 8, 10, 26, 47, 49
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